Information in this document is subject to change without notice and does not represent a commitment on the part of Accelerated Christian Education. The software described in this document is furnished under a license agreement and may only be used or copied in accordance with the terms of the agreement.

aceconnect is a trademark of Accelerated Christian Education.

Microsoft is a trademark of Microsoft Corporation in the United States of America and other countries.

Adobe Acrobat Reader is a trademark of Adobe Corporation in the United States of America and other countries.

© 2014 Accelerated Christian Education, Inc. All Rights Reserved.
# Table of Contents

## INTRODUCTION
- Welcome .......................................................................................................................... 6
- Common Features and Elements ..................................................................................... 6

## INSTALLATION SECTION
- Hardware Requirements ................................................................................................. 8
- Software Requirements ................................................................................................. 8
- Installation Prerequisites ............................................................................................... 9
- Download Steps ............................................................................................................. 11
  - Server Installation ........................................................................................................ 11
  - Client Installation ......................................................................................................... 11
  - Server and Client Installation on a Single Computer .................................................... 12

## LOGIN/GETTING STARTED SECTION
- Login .............................................................................................................................. 13
- Getting Started ............................................................................................................... 14
  - Download the License ................................................................................................. 14
  - Update the Catalog ...................................................................................................... 15

## SETUP SECTION
- School Configuration .................................................................................................... 17
  - Academic .................................................................................................................... 17
  - Billing ......................................................................................................................... 18
  - Contact ...................................................................................................................... 18
  - Inventory ................................................................................................................... 19
  - School .......................................................................................................................... 19
- Academic Year ............................................................................................................. 19
- Roles and Permissions ................................................................................................. 21
- Rooms ............................................................................................................................ 22
- Staff and Users .............................................................................................................. 22
- Subject Types ............................................................................................................... 25
- Subjects .......................................................................................................................... 26
- High School Subjects .................................................................................................. 27
- Grade Conversions ....................................................................................................... 27
- Courses of Study/Graduation Requirements ................................................................ 28
- Grade Types .................................................................................................................. 29
- Standardized Testing .................................................................................................... 29
- Desirable Traits ............................................................................................................ 30
- Relationship Types ...................................................................................................... 30
- Note Types .................................................................................................................... 31
- Billing Plan ................................................................................................................... 32

## STMS DATA IMPORT SECTION
- Preparation .................................................................................................................... 33
- Selecting a Backup from School of Tomorrow Management System ......................... 34
- Running the Data Import .............................................................................................. 34
  - Start the Import .......................................................................................................... 34
  - Step 1 – Select Data .................................................................................................... 35
  - Step 2 – Select Families and Students to Import ......................................................... 35
  - Step 3 – Import .......................................................................................................... 35
  - Step 4 – Review ......................................................................................................... 37
- Follow-Up ..................................................................................................................... 37

## HOME SECTION
- Help Panel ..................................................................................................................... 40
- Dashboard ....................................................................................................................... 40
- Resources ....................................................................................................................... 40
- Find People ...................................................................................................................... 41
- Backup/Restore ............................................................................................................... 42
- Shutdown .......................................................................................................................... 43
FAMILIES SECTION ................................................................. 45
Browse Families ........................................................................ 45
Adding a Family ....................................................................... 45
Editing a Family ...................................................................... 46
Deleting a Family .................................................................... 48
STUDENTS SECTION ....................................................................... 49
Progress Control ...................................................................... 49
Adding Items in Progress Control.............................................. 53
Adding Basic Literature 7 and 8 to Progress Control................. 54
Academic Projection .................................................................. 55
Assigning a Course of Study...................................................... 55
Graduation Requirements .......................................................... 56
Kindergarten ............................................................................. 58
Kindergarten Lessons ................................................................. 58
ABCs ......................................................................................... 59
ABCs Lessons .......................................................................... 59
Post Test .................................................................................... 60
Attendance ................................................................................ 60
Goal Check ............................................................................... 61
Entering Attendance Information .............................................. 61
Entering Goal Check Information .............................................. 61
Adding a Homework Assignment ............................................. 61
Goal Notes ............................................................................... 63
Homework Assignment ............................................................. 63
Merits and Demerits ................................................................. 64
Scripture Memory ..................................................................... 65
Desirable Traits ....................................................................... 67
Standardized Testing ................................................................. 68
Privilege Status ....................................................................... 68
Browse Students ....................................................................... 69
Adding a Student ..................................................................... 70
Editing a Student .................................................................... 72
Deleting a Student ................................................................... 72
BILLING SECTION ........................................................................ 73
Balances .................................................................................. 73
Transactions ............................................................................ 73
Adding a Manual Transaction .................................................. 73
Viewing Transactions ............................................................... 74
Reversing a Transaction .......................................................... 74
Deleting a Transaction .............................................................. 74
Miscellaneous Fees .................................................................. 75
Billing Runs .............................................................................. 75
Billing Plans ............................................................................. 76
Batch Transactions ................................................................... 77
INVENTORY SECTION .................................................................... 80
Orders ..................................................................................... 80
Filtering Orders ...................................................................... 80
Creating an Automatic Order .................................................. 80
Creating a Manual Order .......................................................... 82
Uploading a Manual Order File ............................................... 84
Editing an Order ..................................................................... 84
Deleting an Order .................................................................... 84
Receive Order .......................................................................... 85
Browse Inventory ...................................................................... 85
Adding Inventory ..................................................................... 85
Issuing Inventory ..................................................................... 86
Assigning and Reassigning Inventory ..................................... 86
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigning Inventory</td>
<td>86</td>
</tr>
<tr>
<td>Changing Inventory Status</td>
<td>86</td>
</tr>
<tr>
<td>Suppliers</td>
<td>86</td>
</tr>
<tr>
<td>Catalog</td>
<td>87</td>
</tr>
<tr>
<td>Subject Ordering Rules</td>
<td>87</td>
</tr>
<tr>
<td>REPORTS SECTION</td>
<td>88</td>
</tr>
<tr>
<td>iPAD APPLICATION</td>
<td>89</td>
</tr>
<tr>
<td>Logging In and Out</td>
<td>89</td>
</tr>
<tr>
<td>Student Goals and Homework</td>
<td>89</td>
</tr>
<tr>
<td>Homework Slips</td>
<td>89</td>
</tr>
<tr>
<td>Attendance</td>
<td>90</td>
</tr>
<tr>
<td>Review Items</td>
<td>90</td>
</tr>
<tr>
<td>Details</td>
<td>91</td>
</tr>
<tr>
<td>Notes</td>
<td>91</td>
</tr>
<tr>
<td>Homework</td>
<td>91</td>
</tr>
<tr>
<td>Photos</td>
<td>91</td>
</tr>
<tr>
<td>RELEASE HISTORY</td>
<td>92</td>
</tr>
</tbody>
</table>
Welcome

Welcome to aceconnect School Management. This User Guide will explain concepts and application operations to help use the software in your school.

Should you experience difficulty during the installation or with program operation, you may contact our Technical Support team at 615-612-5288. You may also email technicalsupport@aceministries.com.

Common Features and Elements

Throughout the application, certain common features and elements are used. Understanding these features and elements will help you use the software more effectively.

Menu Bar

The menu bar is a container for various action buttons used throughout School Management. Some common action button types are:

Clickable Buttons – New, Edit, Delete, Print, etc.

Toggle Button – Toggles between an On and Off status

Dropdown List – Allows selection from a list

Date Dropdown – Allows manual entry of a date or selection of a date from a calendar

Filter Button – Sets a filter for a grid

Refresh Button – Refreshes the current display by reloading the data
**Data Grid**

Grid elements are used to display data on many screens. Select an item in the grid by clicking on the row.

Sort any grid by clicking on the name of any column.

Filter any grid by clicking the **Filter** button in the menu bar (if available).

Filter any grid by column values by clicking on the small filter button on the upper right corner of any column. From the filter menu displayed, choose **All**, **Blanks**, **Nonblanks**, **Custom**, or any row value to filter the data displayed in the grid.
Installation Section

School Management consists of two main components—a server component (Windows® service) and a client component. These components can be installed in a network configuration (a server computer and one or more client computers) or in a single configuration (both the server and the client components on a single computer).

Hardware Requirements

<table>
<thead>
<tr>
<th>Processor</th>
<th>Client (minimum)</th>
<th>Server (minimum)</th>
<th>Server (recommended)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>800 MHz or faster</td>
<td>1GHz or faster</td>
<td>1GHz or faster dual core processor</td>
</tr>
<tr>
<td>Memory</td>
<td>512MB</td>
<td>2GB</td>
<td>4GB+</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>Any</td>
<td>100GB</td>
<td>250GB+</td>
</tr>
</tbody>
</table>

Software Requirements

Required software must be in place before School Management can be installed. Below are the software requirements for both the server and client computers if installed separately. If installed on a single computer, the server requirements are recommended.

<table>
<thead>
<tr>
<th>Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows® 7 (SP1), Microsoft® Windows® 8, Microsoft® Windows® 10, or Microsoft® Windows Server® 2008-SP1 (or any higher version)</td>
</tr>
<tr>
<td>Adobe® Acrobat® Reader® (for viewing the User Guide)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows® 7, Microsoft® Windows® 8, Microsoft® Windows® 10</td>
</tr>
<tr>
<td>Adobe® Acrobat® Reader® (for viewing the User Guide)</td>
</tr>
</tbody>
</table>
Installation Prerequisites

Listed below are prerequisites that need to be installed in order to run School Management. If you have Internet access and the computer is current with all Microsoft updates, these prerequisites will be installed when running the School Management installation.

If you do not have Internet access, you will need to manually download these prerequisites from Microsoft, copy them to your computer, and install them before running the School Management installation.

- **To install DOT NET Framework 4 in Windows 7**

- **To install .NET Framework 3.5 in Windows 8.1 or Windows 10**
  - Right-click the Windows logo in the lower left corner of the desktop.
  - Select Programs and Features.
  - Select Turn Windows features on or off from the left side.
  - Click the [+ ] beside the checkbox for .NET Framework 3.5 (includes .NET 2.0 and 3.0), and check all the boxes below it.
  - Click OK to activate the .NET framework.

- **To install Microsoft SQL Server 2012 Express 32-bit**
  (only needed for the School Management server installation)
During the installation for SQL Server, you can accept all default settings except on the Instance Configuration screen, where you will choose a named instance and type the name sms.
Download Steps

1. Click the Download Link provided in the Registration email and set up your Portal User Name and Password.
2. Click Download Installer, then click Run.
3. Follow the prompts through the installation process.

**NOTE:** For Windows 10, you must first install .NET Framework 3.5 manually.

**Server Installation**
To perform the server installation, choose both SMS Client and SMS Server. The server component (including database and Windows service) will be installed and started. A program icon will be added to the Start menu.

**NOTE:** The SMS Server operates in the background of Windows, so the client component is necessary to access the database on that computer.

**Client Installation**
To perform the client installation, download School Management onto each designated computer. Choose SMS Client and continue. A program icon will be added to the Start menu.
Server and Client Installation on a Single Computer

The server and client components can be installed on a single computer. Choose SMS Client and SMS Server. A program icon will be added to the Start menu.
Login/Getting Started Section

Login

To begin, click the **School Management** icon in the Start menu.

The client component requires a connection to the server component. The application automatically searches for the server and displays it in the Server dropdown list. Enter the default User Name **admin** and the default Password **admin**. **NOTE:** It is highly recommended that you change the default password the first time you log into School Management.

Once initialization is complete, the Dashboard screen is displayed.
Getting Started

To associate your server installation with the Portal account and your A.C.E. account, follow these steps to download the license and update the catalog.

**Download the License**

Until the license is downloaded, the program will only run in demo mode and will only allow one family to be entered. The steps to activating the license are as follows.

Activating the License with Internet Access
1. Open the Home menu and click License.
2. Enter your Portal User Name.
3. Click Change… to enter your Portal Password.
4. The word Success should appear in the Portal Account Status box.
5. Click Download License.
6. Log out of School Management and log back in. The school name will now appear in the program. If it is necessary to change the school name for any reason, contact A.C.E. Technical Support at 615-612-5288. You may also email technicalsupport@aceministries.com.

Activating the License without Internet Access
1. On a computer with Internet access, log in to the Portal at www.studentmanage.com.
2. Click the Licenses tab.
3. Click the License link.
4. Save the file to an external hard drive, flash drive, or other portable device to transport it to the School Management server computer.

**NOTE:** If you have forgotten your Portal User Name or Password, go to www.studentmanage.com. Enter the email address on record for your school, and click Forgot Password. Your user name and a temporary password will be sent.
5. On the computer with the School Management server, **copy the license file** to the program folder.
   - On Windows 64-bit systems the folder is 
     C:\Program Files (x86)\School Management System\
   - On Windows 32-bit systems the folder is 
     C:\Program Files\School Management System\

6. Restart the computer.

Be sure to check the Licenses tab periodically at [www.studentmanage.com](http://www.studentmanage.com) for software updates. Update notifications will also display in School Management at the top right when logged in.

**Update the Catalog**

When School Management is first installed, it will include the basic A.C.E curriculum catalog. It is important to run a catalog update after the installation is complete. The catalog must be updated from this default catalog for ordering to be possible through School Management. Shipping addresses for your account are included in this download.

**Updating the Catalog with Internet Access**

1. Open the **Home** menu and click **Portal Settings**.
2. In the Catalog and Orders section, click **Update Now**.
3. When the update is complete, an entry will appear in the log with a time stamp.

![Image of School Management interface]

**Updating the Catalog without Internet Access**

1. On a computer with Internet access, log into the Portal at [www.studentmanage.com](http://www.studentmanage.com).
2. Click the **Updates** tab.
3. Click **Download Latest Catalog File**.
4. **Save the file** to an external hard drive, flash drive, or some other portable device to transport it to the School Management computer.

5. On the computer with School Management, log into the program.

6. Open the **Inventory** menu and click **Catalog**.

7. Click **Manual Update** and select the catalog update file that you downloaded from the Internet.
Setup Section

To set up School Management, click Setup in the left panel.

School Configuration

The School Configuration section contains basic school information. Open the page by clicking Setup. The default page displays School Configuration.

Academic

- Auto Issue PACE – Automatically issues the next PACE (if in stock) when a passing score is entered for the student
- High School Avg – Controls whether the overall High School Average is calculated using only PACE subjects, only Non-PACE subjects, or both (default)
- High School Avg Use GPA Weight – Controls whether the Overall High School Average is calculated using the GPA Weights for each subject (defaults to off)
- Minimum Score – The default minimum passing score for any PACE or academic item as established when setting up subjects
Billing

- Bill PACEs – Determines when PACEs are billed for each student
- PACE Fee (Per PACE) – The amount billed for each PACE issued to a student
- Plus Repeat PACE fee – The additional amount billed for each repeat PACE issued to a student
- Plus Percentage of PACE Cost – Provides an option to add a percentage of the PACE cost to the PACE Fee (Per PACE) amount that is billed for each PACE issued to a student.
  - If the school’s PACE cost is $2.48 and 150% is entered in this field and the PACE Fee (Per PACE) is set at 0.00, the PACE will be billed at $2.48 \times 150\% = $2.48 \times 1.5 = $3.72.
  - If the PACE Fee (Per PACE) is set at $3.00 and the Plus Percentage of PACE Cost is set at 50%, for a PACE that costs the school $2.48, the program will bill $3.00 + ($2.48 \times 50\%) = $3.00 + $1.24 = $4.24
  - NOTE: If you want to bill using the PACE fee (Per PACE) field, the amount on the Plus Percentage of PACE Cost line must be set at 0%.

Contact (School contact information)

- Fax
- Mailing Address (where the school receives mail)
- Mailing Address 2
- Mailing City
- Mailing Country
- Mailing ZIP/Postal Code
- Mailing State/Province
- Phone
- Physical Address
- Physical Address 2
- Physical City
- Physical Country
- Physical ZIP/Postal Code
- Physical State/Province
Inventory

- Allow Online Ordering – Determines whether the system will automatically order PACEs
- Order PACEs Ahead – Indicates the number of PACEs per subject to order ahead for each student when Allow Online Ordering is checked
- Use Free Floating Mode – Determines how ordered and inventory PACEs are handled. In Free Floating Mode, the program uses smart logic to determine when to order PACEs but does not assign them to a specific student. PACEs added to inventory manually will be assigned by the program to a student as the need for the PACE arises.

When Free Floating Mode is off, all PACEs ordered are allocated to the student that caused the item to be ordered. PACEs added to inventory manually must be assigned to a student or they will remain in inventory unused and the program will continue to order new PACEs as if those particular PACEs do not exist.

School

- Administrator Name
- Logo

Click in the area below Administrator Name, then right-click to access the image options menu. Your logo will display in the upper left next to the school name and on any printable report.

Academic Year

The Academic Year section contains academic records for all years included in the program. Open Setup and click Academic Year.

To create and configure an academic year, click New. Type a Name (e.g., 2016-2017), enter the Begin Date and End Date values, and click Save.
After saving, configure the following details for the Academic Year.

- **Period Type** – The type of period desired. Options are Quarter, Trimester, and Semester. After choosing the Period Type, configure each period with Name, Start Date, and End Date. Click **Update**. Use the slider to advance to the next period. Continue this process until all periods are configured.

- **School Days** – Valid school days are highlighted on the School Days calendar. Click any day in the calendar to toggle the school day on or off.

**NOTE:** The School Days Calendar provides the record for the number of school days in session that appears on the Permanent Record. It is important that any days school is not in session be toggled off and all days in session be toggled on for accurate reporting.
• Click **Set as Current** on the top menu. A green check mark will appear on the row for that academic year.

Additional actions include:
• Save – Save the academic year that is currently being edited.
• New – Add a new academic year.
• Delete – Click the year you wish to delete and click **Delete**.
• Set as Current – Click the year you wish to set as the current academic year, and click **Set as Current**.

If this is a newly created year with no information added yet, a prompt will allow you to choose which students to reenroll. Confirm the levels and supervisors for each reenrolled student, then click **Save**. You can still enroll individual students later.

All prescribed PACEs/Units without scores on the Student Progress Control for the current year will be moved to the new Progress Control to be completed in the new year.

---

**Roles and Permissions**

School Management includes the following default roles.
• Administrators
• Supervisors
• Monitors
• Secretary

To add a new role, click **New**. The Roles and Permissions dialog box will appear.
Enter a name for the new role and select the desired permissions. Click **Save**.

To modify the permissions for any role, select the role and click **Edit**.

### Rooms

To add a new room, click **New**, enter the Name. To allow PACEs, resource books, etc. to be assigned to that room, set the values for Can Have Inventory? Set the values for Is Learning Center? Navigating to another row automatically saves the new room.

To edit a room, select it and modify the desired values.

To delete a room, select it and click **Delete**.

### Staff and Users

The program installs with one staff account named admin. If only one person will be using the program, one account is sufficient. If there will be additional users, set them up now. Add staff by opening the **Setup** menu and clicking **Staff and Users**.
NOTE: Rooms must be added before adding Staff and Users. Staff cannot be assigned to a Learning Center until it is added in the Rooms section.

To set up a new staff person or user, click New. The Select Person dialog box will display. You may search for an existing entry or click Add New Person at the bottom.

A dialog box will appear. Enter data in each of the fields and click Save. NOTE: Only the bold fields are required.
To edit an existing user, select the person and click **Edit**. The Edit Staff dialog box will appear.

In the Edit Staff dialog box, enter the following and click **Save**:

- **User Name** – Enter a user name for logging in.
- **Password** – Enter the desired password in both the Password and Verify fields.
  - Passwords are case sensitive.
  - Be sure to reset the admin password if that hasn’t been done. See page 13.
• Staff Roles – Select the desired role(s) for the user.
• Room – Select the room to which the staff person is assigned (optional).
• User Is Locked Out – If this box is checked, the user will not be allowed to access School Management. 

**NOTE:** If the admin account experiences password lock-out due to too many log-in attempts, contact Technical Support at 615-612-5288 for assistance.

• User Must Change Password – Select this box to force the user to enter a new password the first time he logs in.

To edit a staff person or user, select the name and click **Edit**.

---

**Subject Types**

To add a new subject type, click **New**. Enter the desired name and a color (optional).

To edit a subject type, click on the desired row and modify the value you wish to change.

To delete a subject type, click on the desired row and click **Delete**.

**NOTE:** Default subject types cannot be edited or deleted.
Subjects

If your school has custom subjects that are not part of the A.C.E. curriculum catalog, add them to School Management.

To add a new subject, click **New**. The Subject dialog box will appear.

Enter the following and click **Save**:

- **Name** – Enter the name of the subject.
- **Subject Type** – Select the desired Subject Type from the dropdown list.
- **PACEs/Units per credit** – Select the number of PACEs/Units per credit.
- **GPA Weight** – Select the weight (percentage) to be used for the subject when calculating the GPA. Depending on the High School Avg Use GPA Weight option in Setup > School Configuration (see page 17), these GPA Weights may also be used to calculate the Overall High School Average.
- **Is PACE** – Select the check box if the subject is a PACE subject.
- **Starting PACE/Unit** – Select the starting number.
- **Ending PACE/Unit** – Select the ending number.
- **Min. Passing Score** – Select the minimum passing score for this subject. This will override the minimum score entered in the Academic section of School Configuration.

To edit a subject, click on the subject row and click **Edit**.

To delete a subject, click on the subject row and click **Delete**.

**NOTE:** Default subjects cannot be edited or deleted.
**High School Subjects**

When adding a subject that can result in high school credits for multiple years, set it up with a unique name each year (e.g., Physical Education I, Physical Education II, etc.).

Some areas, such as California and Indiana, use a different value system for high school credits other than one credit for a full-year course. These schools must edit all **Subjects** so the values indicate the correct number of credits before adding or importing any student records.

Example—California 10 credits per year:

![Subject setup example](image)

**Grade Conversions**

The Grade Conversions menu item shows the grading scale used by School Management. The program defaults to a 4-point grading scale. If your school uses a different scale, set it here.

Grade conversions determine the corresponding letter grade based upon numeric scores. They are linked to the current academic year, and default conversions are added any time a new academic year is added.

![Grade Conversions example](image)

**NOTE:** You must set up the Academic Year prior to modifying Grade Conversions.
To edit an existing grade conversion, click on the item and modify the desired values.

- **Letter Grade**
- **Min Score** – the minimum score for the letter grade
- **Max Score** – the maximum score for the letter grade
- **Grade Points** – the grade points for the letter grade (used when calculating student GPAs)

**Courses of Study/Graduation Requirements**

School Management is preconfigured with four Courses of Study.

- **Honors**
- **College Preparatory**
- **General**
- **Vocational**

It is recommended that you make adjustments to the default Courses of Study to reflect your school’s requirements.

To add a custom Course of Study, click **New**. Enter text for Name and Total Required Credits. The Base Credits will be automatically calculated as subject requirements are entered.

To delete a Course of Study, select the item and click **Delete**.

To add subjects for a Course of Study, click **New** in the Subjects grid. Enter the number of credits, select the Subject Type, and select the Subject. Any subject your school requires for all students in a particular Course of Study should be added to that Course of Study. For example, if your school requires Old Testament Survey for all students on the College Preparatory Course of Study, add that course to the College Preparatory Course of Study.
To delete a subject from a Course of Study, select the item and click **Delete**.

---

**Grade Types**

Grade Types are used to define student levels in School Management.

To add a new Grade Type, click **New** and enter the following information:

- Name – the name of the grade level
- Short Name – the number of the grade level
- Order – the sequential order of the grade type
- Allow Kindergarten – Checking this box makes kindergarten items available for this grade type.
- Allow ABCs – Checking this box makes ABCs items available for this grade type.

To delete a grade type, select the item and click **Delete**.

**NOTE:** Grade Types cannot be deleted once students have been assigned to them.

---

**Standardized Testing**

The Standardized Testing setup allows you to enter any number of standardized tests and score areas for tracking.

To add a standardized test, click **New**. The Add New Standardized Test dialog box will appear. Enter text for the Name and Provider. Click **New** to add Score Areas and minimum and maximum scores for each section being added. Once all desired Score Areas have been added, click **Save**.

To edit a standardized test, select the item and click **Edit**.

To delete a standardized test, select the item and click **Delete**.
Desirable Traits

Desirable Traits are grouped by category. To collapse a category, click the “-” symbol. To expand a category, click the “+” symbol. You can also collapse or expand all categories using the appropriate buttons on the toolbar.

To add a new desirable trait, click New and enter the Name, Category, and Sequence. Navigating to another row automatically saves the new desirable trait.

To edit a desirable trait, select the item and modify the desired values.

To delete a desirable trait, select the item and click Delete.

Relationship Types

To add a new relationship type, click New and enter the name. Navigating to another row automatically saves the new relationship type.
To edit a relationship type, select the item and modify the name.

To delete a relationship type, select the item and click **Delete**.

---

**Note Types**

School Management allows you to add notes to certain areas of the program. The type of note determines its behavior in the area in which it is used.

To add a new note type, click **New**. The Note Type dialog box will appear.
Enter the desired name and whether or not the note type allows merits and demerits (both of which are optional). Next, add Note Subtypes as desired by clicking New. Enter the name and the merits or demerits as required. Click Save when all items have been entered.

To edit a note type, select the item and click Edit.

To delete a note type, select the item and click Delete.

---

**Billing Plan**

Before adding families to School Management or importing families from School of Tomorrow Management System, you must first set up at least one billing plan. Open the Billing menu and click Billing Plans. For additional information, see page 76.

**Note:** You may need to restart the program when completing setup in order for the billing plans to display.
STMS Data Import Section

STMS Data Import will import your existing records from the School of Tomorrow Management System into aceconnect School Management. The import will copy existing records for any families you select, all the students in that family, and all the students’ subjects and grades. The import will not include attendance records, discipline records, Scripture memory, Readmaster Plus® records, standardized tests, photographs, financial records, or inventory.

Preparation

Before importing records from the School of Tomorrow Management System, you must first complete the steps listed in the Setup Section beginning on page 17. The STMS Data Import cannot be run until you first set up your current school year, at least one billing plan, and at least one staff member in School Management. In case you miss any of these preparatory steps, the STMS Data Import will alert you before allowing any records to be imported.

Since STMS only displays a completion date for completed subjects, School Management imports PACEs based on the beginning and ending dates (month and day) the user inputs when the initial school year is set up. These beginning and ending dates (month and day) become the default beginning and ending dates for all prior years subjects imported into School Management.

It is possible that credits for some subjects (those completed outside the range of dates entered above) may be assigned to an incorrect school year. To minimize the number of times this happens the user has two options.

1. **(Recommended)** Set up the initial school year with a beginning date of August 1 and your school’s actual ending date.
Once the import process is complete, go back into the Setup menu and change Begin Date to your school’s actual beginning date.

2. In the Setup menu in School Management, set up previous school years with the actual beginning and ending dates of each school year prior to the current one (as far back as you want to be certain all credits import in the correct school year).

Selecting a Backup from School of Tomorrow Management System

The STMS Data Import requires a backup of your current School of Tomorrow Management System records. If you don’t already have a current backup, you must make one.

1. Open School of Tomorrow Management System.
2. Click File > Utilities > Backup Data.
3. Select a location to place your backup.
   a. If the aceconnect School Management server is running on the same computer as your School of Tomorrow Management System, you can save the backup in the C:\STMS\ Folder.
   b. If the aceconnect School Management server is running on a separate computer, save the backup to a portable external hard drive or flash drive so you can transport the backup file to the computer with the School Management server.

Running the Data Import

The steps to open and run the STMS Data Import are as follows and must be completed on the aceconnect School Management server computer. The STMS Data Import cannot be run from a client computer.

Start the Import

On the Windows Start Menu, select All Programs, then select School Management System. Select STMS Data Import.
For Windows 8, select **Start**, then open **STMS Data Import**.

**Step 1 – Select Data**

1. Click **Select** and find your backup file from School of Tomorrow Management System.
2. Select the server for School Management. The server should be located automatically; however, you can type in the location.

**Step 2 – Select Families and Students to Import**

- All family accounts included in your backup from School of Tomorrow Management System will display in a list. Select the families you wish to import into School Management. It is recommended that you import all families. However, you can import a single family to see how the process works and run STMS Data Import again to import the remaining families.
- The students in the currently selected family will display on the right. Although only students for one family will display, all students for each family you select will be imported.
- The option to Import PACEs as Billed displays on the bottom right. Choose **Yes** or **No**. Or click **What’s this?** for more information.

**Step 3 – Import**

During this process the families and students you selected will be imported and the progress will display. Dialog boxes may ask for input throughout the process.

---

**NOTE:** Only records from School of Tomorrow Management System version 3.1.1 can be imported into aceconnect School Management. If your version is older than 3.1.1, the import utility will not allow the import. Upgrade School of Tomorrow Management System to 3.1.1 and then run the import.
• Link or Add a Subject – This message will appear if a subject from your School of Tomorrow Management System records is not found in School Management.

• Enter a Subject Grade – This message will appear if a student’s subject does not have a valid grade to import into School Management. Review the student’s past records to determine what grade to input.

• Enter a Valid Date – This will appear if an invalid date is encountered during the import. You will need to enter a correct date.
Step 4 – Review

A final report displays three lists to indicate any errors within the import. You will need to manually add those items to School Management. **It is very important that you write down any errors before closing the STMS Data Import.**

---

Follow-Up

After running the STMS Data Import, you are now ready to finish setting up School Management.

- Assign a staff member and a Learning Center for each student. This must be done since STMS Data Import assigns all students to the School Management default staff member. If you have multiple supervisors, assign
each student to the proper supervisor. This can be done on the student’s enrollment screen for the current year. Previous years are assigned to the default supervisor. For more information, see page 23.

- The School of Tomorrow Management System program defaulted to a 3.0 GPA and used a grading scale that did not allow pluses and minuses (A-, B+, B-, C+, C-) for PACE scores. The School Management program defaults to a 4.0 GPA and does allow pluses and minuses for PACE scores. Because of this upgrade, the GPA for a particular student in a particular year in School of Tomorrow Management System may be slightly different than the GPA for the same student in the same year in School Management. This is not an error; it is the result of an upgraded method of calculation.

- Carefully check each high school student’s Academic Projection.
  - Any incorrect subjects can be deleted or edited in the Graduation Requirements section of the Academic Projection.
  - Since non-PACE subjects entered in School of Tomorrow Management System do not have a completion date, any non-PACE subjects listed as Current on the Academic Projection in School of Tomorrow Management System are imported into the academic year you set as the current year when you set up School Management.

For example, if you select the 2014-2015 school year as your current year in Setup of School Management, non-PACE subjects listed as Current on the Academic Projection in School of Tomorrow Management System will be imported into that year, regardless of the actual school year in which they were completed.

- Following the completion of the import process, a Supervisor’s Progress Report and a Permanent Record will be available for all previous years a student was enrolled in your school. Transcripts will be available for
all current high school students. Kindergarten Progress Reports and ABCs Progress Reports will not display completed PACEs. The Student Progress Report will only display completed PACEs for the current academic year.

• Set each family’s Billing Plan. The STMS Data Import assigns each family to your first Billing Plan. If you have multiple Billing Plans, review each family in the Browse Families menu item to verify that they are properly assigned.

• Inventory is not imported through STMS Data Import. Any PACE prescribed to a student in School Management that is not complete must be manually added into inventory before placing orders. See page 85 for the steps to add PACEs to inventory.

• Before importing any records, the STMS Data Import first makes a backup of your School Management records. This can be very helpful if you make a mistake during the import and need to undo the changes and run the import again. You can restore the backup in School Management by opening the Home menu and clicking Backup/Restore. With this in mind, you can import your School of Tomorrow Management System records, use the program for a while to become comfortable with it, and then restore the backup to start over.

• If your current backup from School of Tomorrow Management System only contains current students, you can run the STMS Data Import multiple times with older backups to import other students. Keep in mind that if you import a family multiple times, duplicate families will display in School Management. You will need to delete the duplicate.
Home Section

The **Home** screen is displayed each time you start the aceconnect School Management client.

Help Panel

The Help Panel on the right displays links to the About dialog box and the **User Guide**.

Dashboard

The Home section displays the Dashboard, providing a quick view of Scripture Due and Homework Due.

Resources

Manage books and DVDs with this option.

To add a new resource item, click **New** and enter the appropriate information. If desired, include the Location, the student to whom the item is Checked Out, and the CO Date (Checked Out Date). Be sure to save the data.
To check in a resource, select the item and click **Check In**. The status will be reset to Not Checked Out.

To edit a resource, click on the item and modify the desired information.

To delete a resource, select the item and click **Delete**.

**Find People**

To access information for a particular person, click **Find People**. Searching can be done by name or phone number. Type the beginning of the name or phone number as appropriate. The results of your search are displayed in the results grid.

Click to highlight the desired name, then click **Edit**. The Edit Person dialog box will display. Information may be viewed or edited and saved.
NOTE: The user’s ability to view information depends on the roles and permissions assigned to him. See page 21.

Backup/Restore

To back up or restore the program database, click Backup/Restore. A list of existing backups will display.

To back up your system, click Backup. Choose Backup Database Now in the dialog box. You can choose to back up to the default location or to a custom location. A custom location could be another folder on the computer or network, flash drive, or external hard drive. Backups to the default location are included in the list of backup files.

To restore a backup, select it in the list and click Restore. Choose Restore Database Now on the dialog displayed.

WARNING: This action will overwrite any existing data.
When you click **Restore**, you can also click **Browse for Other Backup File** and select a backup you have saved in another folder on the computer or network, flash drive, or external hard drive.

To delete an existing backup, select the backup in the list and click **Delete**.

**Shutdown**

The Shutdown feature allows you to shut down the School Management program for maintenance. A message will be sent to any remote computers running the program. It is recommended that you do not use this feature unless directed by A.C.E.

**License**

School Management requires a valid license file to fully enable all features. Click **License** to manage your license file. Your Portal User Name and Password should have been set in the Portal, but if desired it can be modified here. Click **Download License** if you need to download your license file for any reason.
Portal Settings

The Portal is the online server accessible with a valid license at www.studentmanage.com. The Portal Settings section shows your account status and allows the Portal Password to be changed. For schools who order from A.C.E. in the United States, the Portal enables School Management to automatically update the catalog, process automatic orders, handle software licenses, and process payments.

To change your Portal Password, click Change…. Enter your New Password and click OK.

For automatic catalog updates, select Enable Catalog Updates and Electronic Orders (if available from your warehouse). Updates are pushed through each day at a predetermined time. You may change this time if desired.

NOTE: Your school name is automatically set in the program from your license file and cannot be modified. If your school name is displayed incorrectly, you must contact A.C.E. Customer Service to modify it.
Families Section

Families must be entered in School Management before adding students. Families are added, edited, and managed from the Families menu. **NOTE:** A Billing Plan must be set up before adding families. See page 76.

Browse Families

The Browse Families feature provides a quick view of all families. Families are added, edited, and deleted here.

Adding a Family

To add a family, click New Family Wizard. The following steps will display. **NOTE:** Items in bold in the wizard are required fields.

- Adding a new family – This is the startup screen for the wizard. Click Next.
The Add New Family dialog box will appear.

- Primary Person – Enter the information for the head of the family and click Next.
- Secondary Person – Enter the information for the secondary person for the family and click Next.
- Billing Information – Select the mailing address and choose a Billing Plan. Click Next.
- Students – Enter student information. To enter multiple students, click the green + icon. To remove a student, click the red x icon. When you have finished entering students, click Next.
- Ready to Create Family – Review the summary of actions to be taken. If correct, click Finish.

**Editing a Family**

To edit an existing family, select the family in the list and click Edit. Enter text in the following fields in the Edit Family dialog box.

- Primary Person – Click at the end of the name field to select a person or to add a new person. Click the pencil to edit the current person’s information. A Primary Person is required for each family.
- Secondary Person – Click at the end of the name field to select a person or to add a new person.
  
  Click the pencil to edit the current person’s information. Click to delete the Secondary Person.
- Mailing Address – Select an address from the dropdown list. Addresses entered for the Primary and Secondary Persons are displayed.
- Billing Plan – Select a Billing Plan from the dropdown list.
- Billing Name – The Billing Name for the family is created automatically. To change the Billing Name, enter the desired name in the field and click **Automatically Set Billing Name**. Clicking **Automatically Set Billing Name** a second time returns Billing Name to the default setting.
- Students Tab – Add and manage student information for the family. It is important that you click **Edit** on the Students tab, then click the **Address** tab and select the appropriate mailing address. The program defaults to Use Custom Address and will print blank student address labels if an address is not selected.
- Notes Tab – Add notes for the family.
- Parent Portal Tab – If the Parent Portal option is enabled, clicking **Add** allows you to grant access to a member of this family by creating login keys. The family member must have an email address defined in order to gain access. Once a family member is added, an email is sent allowing him to complete registration by choosing a User Name and Password.
Deleting a Family

To delete a family, select the family in the list and click **Delete**. A confirmation dialog box will be presented.

Click **Delete** and the family will be removed.

**Important:** Deleting a family will cause all associated children/students and their academic information to be deleted as well. This action cannot be undone.
Students Section

Academic components are managed and tracked in School Management in a variety of ways. The student must be added before entering and managing student data. The Add Student menu item can be accessed in one of two ways:

- From the **Families ➔ Browse Families** menu options, click on a family and click **Edit**. The Edit Family dialog box displays. Click the **New** tab in the student grid. The Add Student dialog box will appear. Enter the appropriate information.
- From the **Students ➔ Browse Students** menu options, click **New**. The Add Student dialog box will appear.

**Progress Control**

The Progress Control area allows you to view prescribed subjects and scores entered. The Academic Year dropdown list defaults to the current academic year but also allows you to view previous academic years. When a student is selected, the Grade Level for the selected academic year displays in the header row.

To view subjects and scores, select the desired student from the dropdown list. Once a student’s information is added, his subjects and assigned PACEs will display. Each PACE is color coded by status—Prescribed, Issued, Ordered, In Stock, Passed, or Failed.

blers  = Prescribed  = Issued  = Ordered  = In Stock  = Passed  = Failed

Passing scores display in **green**, and failing scores display in **red**.
The following menu items are included in the Progress Control section:

- New Subject – Click to add a new subject for a student. A Student Subjects dialog box will display.

Non-High School Student

High School Student

Select the Subject Type from the dropdown list to populate the available subjects; then choose the desired Subject. The Display Name defaults to the Subject name and in most cases should not be changed. Select the No. of PACEs/Units and Starting PACE/Unit.

The Ordering Prerequisite dropdown list allows you to choose to prevent School Management from ordering two subjects within a subject type at the same time. For instance, if you do not want to automatically order
Algebra II PACEs until Algebra I PACEs are complete, select Algebra I from the dropdown list. Leave this value empty if it does not apply.

Click **Save** to add the subject.

- **New PACE** – Click to add PACEs to an existing subject, such as gap PACEs. The Add PACE dialog box will appear. Select the **Starting PACE/Unit** number and the **No. (of PACEs) to Add**. Click **Insert**.

![Add PACE](image)

- **Delete PACE** – Click to delete a PACE. Make sure to click on the **PACE** you wish to delete prior to clicking **Delete**. A confirmation dialog box will display, allowing you to confirm the delete.

![Confirmation](image)

- **Acad. Year** – Displays the current academic year. Other academic years are accessible using this dropdown list.
- **Grade Level** – Displays the student’s grade level corresponding to the academic year selected.
- **Add Completed Subjects** – After a Course of Study has been selected in the Academic Projection section, click to add completed subjects. **See page 55**. This may be necessary for a transfer student or to correct an omission. The Add Completed Subject(s) wizard will walk you through this process.
**NOTE:** If a letter grade is added in the Grade field, the letter grade will override a numerical grade entered in the Average field.

- **Ordering Rules** – Click to select the curriculum edition you would like to order for this student. The setting of (auto) automatically defaults to Fourth Edition where available. Click in the **Preferred Edition** field of the subject you wish to change.
Subject Names/Buttons – Each subject name is a clickable button, allowing you to edit the existing subject. Click the subject name to open the Student Subjects dialog box. Modify the values as desired and click **Save**.

Run Report – This feature on the right panel displays applicable report links for the student. Click any link to run that report for the selected student.

**Editing Items in Progress Control**

After items have been prescribed to a student in Progress Control, they may be edited by right-clicking the item to display a pop-up menu. The following options are available.

- **Issue** – This allows you to issue the item to the student. This should be done when you are physically handing the PACE to the student. A PACE can only be issued if it is available in inventory. If your School Management user account has administrator permissions or has permission to “Override Inventory,” you can override the requirement to have the PACE in inventory before issuing. The PACE is not subtracted from inventory. Caution should be used when overriding inventory to avoid causing errors in inventory amounts. Non-PACE subjects are issued without being tracked in inventory.

- **Assign** – This option will reserve the PACE in your inventory for the selected student.

- **Un-Issue** – This allows you to un-issue a PACE for a student and adds it back into available inventory. If the PACE was issued by overriding the inventory, it is not added back into the available inventory.

- **Mark as Passed / Mark as Failed** – When a score is entered, School Management will automatically mark the item as passed or failed depending on the minimum score set on the Setup > School Configuration screen. In certain situations you may choose to make an exception.
and mark an item as passed even if it's below the default minimum score. This option allows you to switch the status of a PACE from Failed to Passed or from Passed to Failed respectively.

- Completion Date – The completion date is automatically set as the date you enter the score. If needing to change the completion date of an item, select this option and enter the alternative date.
- Delete – This option deletes the selected item but does not add the PACE back into inventory.
- Cancel – This option closes the menu.

**Adding Basic Literature 7 and 8 to Progress Control**

Basic Literature 7 and 8 must be added as non-PACE subjects to allow you to enter grades for each individual Study Guide. Follow these steps to add a non-PACE subject.

- From **Setup → Subjects**, click **New**. Enter the subject Name, select the Subject Type from the dropdown list, enter 12 PACEs/Units per 0.5 credit(s), and enter the GPA Weight. Click **Is PACE** to remove the default checkmark. Enter the Starting and Ending PACE/Unit and click **Save**.

![Subject window](image)

- From **Students → Progress Control**, click **New Subject**. Select the Subject Type and the Subject from the dropdown lists. Set the No. of PACEs/Units to 12, and set the Starting PACE/Unit appropriately. Click **Save**. The subject will display in Progress Control.

---

**NOTE:** Because Basic Literature 7 and 8 are set up as non-PACE subjects, they have to be billed manually.
• Delete the PACE/Unit numbers not needed for the subject. The remaining PACE/Unit numbers will display in Progress Control. Other non-PACE subjects can be added using these steps.
• **NOTE:** PACE Order Labels will not print for Literature 7 and 8 since they are entered as non-PACE subjects.

### Academic Projection

In Academic Projection you will manage high school graduation requirements with grids for Graduation Requirements, Current Year Subjects, and Previously Completed Subjects.

### Assigning a Course of Study

To view or edit graduation requirements, choose a student from the dropdown list. His Course of Study displays in the header row. To assign or change a student’s Course of Study, make a selection from the dropdown list. The Academic Projection is then populated with values for the student’s Graduation Requirements.
To remove a student’s assigned Course of Study, click **Remove**. Any custom requirements that have been added for the student will be reset.

The Active button allows you to display only active students or both active and inactive students.

Add a new item by clicking **Add** in the menu bar. Enter the credits and subject.

Delete an existing item by selecting it and clicking **Delete** in the menu bar.

**Graduation Requirements**

Graduation requirements for the selected student display in the Graduation Requirements grid. This grid includes columns for Credits, Subject, and Required check boxes.

**Only subjects included in the Graduation Requirements section of the Academic Projection will be issued high school credit that will display on the student’s transcript.** If you prescribe additional subjects that are not listed in the default Graduation Requirements, you must add them to Graduation Requirements in order for them to appear on the student’s transcript.

For example, the College Preparatory Course of Study requires New Testament Survey as a Bible elective. However, a student may also take Old Testament Survey. Old Testament Survey must be added to Graduation Requirements for that student or high school credit will not be given and the course will not display on the transcript.

- Add a new Graduation Requirement by clicking **Add** in the menu bar. Enter the credit and subject.
- Delete an existing Graduation Requirement by selecting it and clicking **Delete** in the menu bar.
- Modify credits by entering new values directly in the Credits field.
- Modify subjects in the dropdown list in each individual Subject field.
- Rename a subject by right-clicking on the desired item and choosing **Change Subject Name** from the pop-up menu. A dialog box will prompt you for the new name. Enter the desired name and click **Save**.

**NOTE:** Items modified in the Graduation Requirements grid affect the selected student only. Modifications in this section do not change the Course of Study default values.
The program highlights the Graduation Requirements in blue or green to indicate which subjects are current or completed.

The student is automatically given high school credit as he completes PACEs or Non-PACE Units that match his Graduation Requirements. In some cases the program is not able to assign these credits automatically. In those situations you can manually link the PACEs or Non-PACE Units to the Graduation Requirement in order to give credit. Some examples of when you might need to link subjects are as follows:

- You are awarding high school credit to a vocational student for PACEs below 1097.
- A student transfers a subject from another school.

To link specific subjects to a Graduation Requirement for a student, right click on the required subject and click **Link Completed Subjects**. A form will display showing all completed PACEs/Units for the subject. Check the items to link them to the Graduation Requirement and click **Save**.

**Current Year Subjects**
Subject and Credits columns display in the Current Year Subjects grid. The Credits column shows the number of credits completed and the number of credits possible for each subject.
Previously Completed Subjects
Completed subjects display in the Previously Completed Subjects grid. This area includes Credits, Subject, Average, and (academic year) Completed. These items can be modified:

- Modify credits by entering new values directly in the Credits field.
- Rename subjects by right clicking on the desired item and choosing **Change Subject Name** from the pop-up menu. A dialog box displays that will prompt you for the new name. Enter the desired name and click **Save**.

![Description for: Algebra II](image)

Credits/GPA
This grid displays information related to the student’s required credits and GPA.

- Required – The number of base credits required for graduation
- Electives – The number of elective credits required for graduation
- Total Required – The total number of credits required for graduation. This value can be modified by entering a new value. **NOTE:** Modifying the total required credits will cause the electives value to automatically recalculate.

Kindergarten
This menu item is only enabled when a student is enrolled in a grade level that allows the Kindergarten program.

Kindergarten Lessons
The first time the Kindergarten menu item is accessed for a student, you will be asked if you wish to add Kindergarten lessons. Choose **Add** to assign the lessons. For each lesson displayed, the following areas are available for review.

- Sound Recognition
- Auditory Comprehension
• Oral Work
• Physical Development

Review values for each area are entered using the scale below.

• E – Excellent
• G – Good
• S – Satisfactory
• N – Needs Improvement

**NOTE:** Grades entered for Kindergarten lessons do not save automatically. Make certain to click **Save** before closing or all grades entered will be lost.

---

**ABCs**

This menu item is only enabled when a student is enrolled in a grade level that allows the ABCs program.

**ABCs Lessons**

The first time the ABCs menu item is accessed for a student, you will be asked if you wish to add ABCs lessons. Choose **Add** to assign the lessons. For each lesson displayed, the following areas are available for review.

• Letter Recognition
• Sounding of Letter
• Letter Formation
• Blending of Sounds
• Physical Development
• Bible Memorization (for reference only—this item is not reviewed)

Review values for each area are entered using the scale below.

• E – Excellent
• G – Good
• S – Satisfactory
• N – Needs Improvement
NOTE: Grades entered for ABCs lessons do not save automatically. Make certain to click Save before closing or all grades entered will be lost.

Post Test
Enter the Post Test Score and the Post Test Date in the header row. These items are automatically saved when entered.

Attendance
School Management offers two options for entering attendance. Attendance is a menu item in the Students section that lists all students currently enrolled.

By default the date is set to the current day. However, the date can be changed using the dropdown list or by typing a date into the field. All enrolled students display for the date selected. The following values are available for each student.

- Present – The default selection for each student
- Absent (E) – Excused absence
- Absent (U) – Unexcused absence
- Tardy (E) – Excused tardy
- Tardy (U) – Unexcused tardy
- Suspended

Values are saved automatically.

Attendance may also be entered for specific students in Goal Check.
Goal Check

Select **Goal Check** to enter goal check-related information for a specific student. Select the student from the appropriate dropdown list. The date defaults to the current day but may be changed as needed.

![Goal Check screenshot]

**Entering Attendance Information**

With the current day selected in the **Week Including** dropdown list, select the correct status in the Attendance grid.

**Entering Goal Check Information**

The current subjects display for the selected student. Select the desired Goal Check status from the dropdown list in the correct day for each corresponding subject. Items are saved automatically.

**Adding a Homework Assignment**

School Management offers two options for entering homework assignments.

To add a homework assignment in Goal Check for a selected student, select **New** on the Homework Assignment header row. The Add New Homework Assignment form will display.
• Assigned On – Select the date in the **Week Including** field.

• Due On – Select the date following the **Assigned On** date. **NOTE:** Dates can be changed by using the dropdown list or by typing the desired date in the appropriate field.

• Subject – Select a subject from the dropdown list.

• Task – Defaults to Finish Goal Pages. Modify this field by highlighting and typing a different task.

• From Page – Enter the first page of homework.

• To Page – Enter the last page of homework.

• Notes – Type a message for the parent or student if desired.

Click **Save** when all information has been entered. If the selected student has homework in other subjects, add it by following the above steps. When all homework for the selected student has been entered, click **Done**. A summary of the homework will appear in the Homework Assignment grid of the Goal Check Report.

To edit a homework assignment, select the subject and click **Edit**. The Edit Homework Assignment form will appear. Make necessary changes and click **Save**. Click **Done** when there are no additional entries to edit.
Click **Delete** to delete a selected homework assignment.

Homework may also be managed in the menu item **Students → Homework**.

### Goal Notes

Goal Notes are managed in the bottom grid.

- **Merits and Demerits** – Click to display a list of all merits and demerits received. Merits and demerits can be added here by selecting **New**.
- **All Notes** – Click to display a list of notes entered for the selected student.
- **New** – Click **New** to add a note for a selected student. The Add Note form will display. Use the dropdown lists to populate the **Date**, **Note Type**, and **Note Subtype** fields. Additional information can be typed in the Text box. Click **Save** when all information is complete. The note will appear in the Goal Notes grid.
- **Edit** – Select the note in the grid and click **Edit**.
- **Delete** – Select the note in the grid and click **Delete**.

### Homework Assignment

Homework assignments can be managed in this menu item. By default, only homework assignments not completed are displayed. To show all assignments, click **Show Completed** on the header row.

- **New** – Selecting **New** will display the Add New Homework Assignment form containing these fields: Student, Subject, Task, Assigned On, Due On, From Page, To Page, Notes, Signed On, Completed On, and Is Printed.
Enter the appropriate values and click **Save** to create the printable Homework Assignment.

- **Edit** – Select the item you wish to edit and click **Edit**. The Edit Homework Assignment form displays. After making edits, click **Save**.
- **Delete** – Select the desired homework assignment and click **Delete**.
- **Print Selected** – Select the homework assignment to print and click **Print Selected**.
- **Print Unprinted** – Select this option to print all unprinted homework assignments.

---

### Merits and Demerits

Merits and demerits are managed in this menu item.

Select a student from the dropdown list.

- **New** – Click **New** to display the Add Note form. All merits and demerits are generated in a student note. Complete all fields and click **Save**.
The entry will display in the Merits and Demerits grid.

- Edit – Select the item you wish to edit and click **Edit**. The Edit Existing Note form will display. Make all desired changes and click **Save**.
- Delete – Select the item you wish to delete and click **Delete**.

**Scripture Memory**

Manage Scripture Memory assignments in this menu item. All current assignments display in the grid.
The following actions are available from the Scripture Memory menu item:

- **New** – Select **New** to display the Add New Scripture Assignment form. After adding a new Scripture passage, click **Save** before assigning the passage to students.
- **Edit** – Select the assignment you wish to edit and click **Edit**. The Edit Scripture Assignment form will display.
- **Delete** – Select the assignment you wish to delete and click **Delete**.
- **Filter** – Select this to toggle between Just My Students or all students in the Scripture assignment grid.

### Add/Edit Scripture Assignment

When adding or editing a Scripture Memory assignment, the following fields can be modified:

- **Passage** – Add the Scripture reference.
- **Start Date** – Add the date manually, or select using the dropdown calendar.
- **Due Date** – Add the date manually, or select using the dropdown calendar.
In the Assign To dropdown list, assign the Scripture to My Students, All Current Students, Select Student, or Select Learning Center.

To unassign a student, select the student and click **Unassign**.

To enter a completion date for a student, click **Edit** and type the date in the Completed Date field. Or select the date using the dropdown calendar. Click **Save** when you have finished modifying items.

**Desirable Traits**

Manage Desirable Traits in this menu option.

Select the desired student from the **Student** dropdown list. Desirable traits are displayed with columns for each academic year period. Enter values in the appropriate columns using the following scale:

- E – Excellent
- G – Good
- S – Satisfactory
- N – Needs Improvement

Entered items are automatically saved.
Standardized Testing

The Standardized Testing menu option allows you to manage standardized test scores for a student. Before entering scores, you must configure Standardized Tests in the Setup section. See page 29.

- New – Click **New** to display the Add New Standardized Test Score form.
  - Student – Select a student to add scores.
  - Test – Select the standardized test for which you are adding scores.
  - Taken On – Select the date the test was taken.
  - Score Areas – Enter the score for each section. Click **Save**.
- Edit – To edit an existing score or test date, select a student and click **Edit**. The Edit Standardized Test form displays. Make all changes and click **Save**.
- Delete – Select the student whose scores you wish to delete and click **Delete**.

Privilege Status

The Privilege Status menu option allows for quick entry of weekly privilege status for all students.

This menu item is for quick entry only. Entered data will be moved from Privilege Status into Goal Notes when you log out of the program. View the entered privilege status in **Students ➔ Goal Check**. Select a student. In the Goal Notes grid, click **All Notes**. The student’s privilege status for the week will display as a note.
• **Add** – To enter privilege status for a student, click **Add**. Select a student and privilege status from the appropriate dropdown list. The **Week Of** field defaults to the current date.

• **Clear** – Clears all data from Privilege Status.

**Browse Students**

The Browse Students menu option allows for a quick view of all students by academic year.

Changing the year in the **Acad. Year** dropdown list will display the students for that academic year.
This menu item also allows the following actions:

- **New** – The Add Student form displays.
- **Edit** – The Edit Student form displays allowing the user to make changes to the student’s information.
- **Delete** – Delete the selected student.
- **Filter** – Filter the display and grouping of students for the academic year.

**Adding a Student**

Click **New** for the Add Student form to display. The following fields can be modified:

- First Name
- Middle Name
- Last Name
- Family
- Gender
- Birthday
- Student ID
- Citizenship
- Date Graduated

Tabs for additional student information are located on the Add Student and Edit Student forms.
**Levels**
This tab displays the student's Academic Year, Level, Supervisor, enrollment Status, and Enrollment Date for each year they were enrolled.

- To withdraw the student, click the appropriate level and click **Withdraw**.
- To enroll the student in a new level, click **Enroll** and make the appropriate selections.

**Notes**
This tab displays the notes for the student.

- To add a note, click **New** and enter the note information in the Add Note form.
- To edit an existing note, select the note and click **Edit**.
- To delete an existing note, select the note and click **Delete**.

**Relationships**
This tab displays Relationships for the student, including, but not limited to, Father, Mother, and Grandparent.

- To add a Relationship, click **New**. Select a person and modify the appropriate information.
- To delete a Relationship, select the Relationship and click **Delete**.

**Contact Info**
This tab displays fields for the contact information listed below.

- Cell Phone
- Home Phone
- Work Phone
- Other Phone
- Email Address
- Twitter
- Facebook
- Website

**Address**
This tab displays addresses for a student. If relationships are defined, you can select from those options. Or, enter a custom address for the student.
Editing a Student

Select an existing student in the Browse Students menu option and click Edit. Make the appropriate changes in the Edit Student form and click Save.

Deleting a Student

To delete an existing student, select the student and click Delete. This action will delete all existing information for the student, including school progress, grades, notes, and anything else you have entered for that student. IMPORTANT: This action is permanent and cannot be undone!
Billing Section

Account balances, financial transactions, and billing activity are managed from the Billing menu.

Balances

The Balances menu item allows you to view the current outstanding balance for each family in School Management. To run the Balance Report, click Print.

Transactions

The Transactions menu item allows you to view, enter, and manage transactions for a family. Choose the family to manage from the Family dropdown list.

Adding a Manual Transaction

To add a manual transaction, enter the details in the Post Transaction area.
Enter information in the following fields:

- Transaction Date – Date of the transaction
- Amount – Amount of the transaction
- Check No. (optional) – The number of the check when the transaction type is Payment
- Transaction Type – Type of transaction including Debit, Payment, and Credit
- Description – A brief description of the transaction
- Details (optional) – A more detailed description of the transaction if desired

Click **Save** to post the transaction.

**Viewing Transactions**

The lower half of the Transactions screen displays transactions for the currently selected family.

**Reversing a Transaction**

Reversing a transaction enters a corresponding transaction of the opposite type into the system. This action has the effect of canceling a previous transaction. To reverse a transaction, select the transaction in the grid and click **Reverse**.

**Deleting a Transaction**

When a transaction is deleted, the record is completely removed, unlike when reversing a transaction. To delete, select the transaction in the grid and click **Delete**. You will only be allowed to delete transactions entered since the last billing run. Transactions from previous billing runs cannot be deleted.
Miscellaneous Fees

Miscellaneous fees (Basic Literature 7, Basic Literature 8, Rosetta Stone, graduation fees, activity fees, etc.) can be billed to a family account one of two ways.

1. Fees can be added manually to each individual family to which they apply by adding a manual transaction. See page 73. This method gives you the option of entering the fee monthly, or as a single transaction.

2. Fees can also be added by creating a specific billing plan that bills the fee as a part of the families tuition cost. For example, the tuition for 7th level students taking Basic Literature would include the price of the Literature PACEs in the tuition cost for that grade level. Using this option, the total Miscellaneous Fees would be divided and billed monthly.

Billing Runs

The Billing Runs menu item displays all previous billing runs in School Management. A billing run is the process that posts all tuition and PACE charges for a specific period. It also posts and reconciles all accounts and transactions that have been entered since the last billing run.

The following actions are available:

- New – Adds a new Billing Run. This action displays the Bill Run processing form. Select the date for the Bill Run and click Process.
• Delete – Deletes a previous billing run. This action will roll back all transactions that were posted with the billing run.

Billing Plans

The Billing Plans menu item displays all billing plans currently configured in School Management.

The following actions are available:

• New – Adds a new billing plan. This action displays the Add Billing Plan form.
• Edit – Allows you to edit an existing Billing Plan. Select the plan you wish to edit and click Edit. The Edit Billing Plan form displays.
• Delete – Allows you to delete an existing Billing Plan. Click the plan you wish to delete and click Delete.

Adding/Editing a Billing Plan

When adding a new Billing Plan, enter the Name and the number of Billing Months desired. Click Save.

When adding or editing a Billing Plan, the following areas and fields are available for modification:

• Tuition Amounts (Annual) – Allows you to designate the amount for each level. If you wish to charge the same amount for all levels, enter a value in Annual Tuition for the level at the top of the list and click Save. Click Make All Same.
• Discounts – Allows you to add discounts for this Billing Plan. All discounts are calculated as a percentage of the tuition amount. An overall discount can be added as well
as discounts for the number of children enrolled up to a total of ten children. If you wish to make all discounts the same, enter a value for 2\textsuperscript{nd} Child and click Save. Click Make All Same.

- Months to Bill – Allows you to designate which months to bill for tuition. Note that the number of months selected should match the Billing Months value. Click the box by the months you plan to bill tuition.

---

**Batch Transactions**

The Batch Transactions menu item allows you to create and assign transactions to multiple families or students at once. This can be used for any transaction type that needs to be applied to multiple families. Examples are field trip fees, enrollment fees, graduation fees, staff family credits, scholarships, etc. You can set up the batch transaction once, and quickly apply it to multiple families or students.
The following actions are available:

- **New** – Adds a new batch transaction. This action displays a new Batch Transaction form.
- **Edit** – Allows you to edit an existing batch transaction. Select the batch transaction you wish to edit and click **Edit**. The Batch Transaction form displays.
- **Delete** – Allows you to delete an existing batch transaction. Click the batch transaction you wish to delete and click **Delete**.
- **Apply Transaction** – Allows you to apply a batch transaction to families or students. Click the batch transaction you wish to apply and click **Apply Transaction**.

**Adding/Editing a Batch Transaction**

When adding or editing a batch transaction, enter data in all the fields and click **Save**.

When adding or editing a batch transaction, the following fields are available for modification:

- **Description** – Allows you to designate a name for the batch transaction.
- **Amount** – Allows you to enter the monetary amount for the batch transaction.
• Apply To – Switches the batch transaction from a per-student transaction to a per-family transaction. This affects who is impacted when you apply the transaction.
• Transaction Type – Options are Debit, Payment, and Credit.
• Details – Allows you to add notes about this transaction.

**Applying a Batch Transaction**

When selecting **Apply Transaction**, the Batch Transaction – Apply screen will display a list of students or families depending on the Apply To option for the selected batch transaction.

Enter a **Transaction Date**, select the students or families to apply the transaction to, and click **Apply**. This will add the transaction to each of the selected families or students. You can then open the **Transactions** menu to see the applied transactions for each family.
Inventory Section

Ordering, inventory, and catalog items are all managed from the Inventory menu.

Orders

The Orders menu item allows you to manage existing inventory orders. This list includes automatic orders sent to A.C.E., as well as any manual inventory orders you may have entered. The following actions are available:

- **New** – Allows you to create a new automatic or manual inventory order. This action displays the Create Order form.
- **Edit** – Allows you to edit/manage an existing order. Click the desired order and then click Edit.
- **Delete** – Allows you to delete an existing order. Click the desired order and then click Delete.

Filtering Orders

By default, the Orders menu item only shows orders from the last 90 days that have not been received. The filter button on the menu bar allows you to change this filter. Selected filters include a check mark beside them in the dropdown filter menu. Available filters include:

- Include Received Orders (This item can be selected with any other item below.)
- Past 90 Days
- Past 180 Days
- Past Year
- All Past Orders

Creating an Automatic Order

Automatic ordering is available when ordering PACEs from A.C.E. When initiating an automatic order, you can select which students to include. This process checks the academic prescription for the selected students, compares the number of PACEs available in each instance, and orders the number of
PACEs required. When selecting students, you can change the number of PACEs to order ahead for a student.

On an automatic order, you can also check the box to **Replenish PACE Inventory**. This will scan your inventory and will add to the order any items needed to meet the **Auto-Stock** amounts set in the Inventory > Catalog screen. See page 87 for editing your **Auto-Stock** amounts.

For automatic orders, the supplier is A.C.E. The PO number is automatically created for you. However, if you wish to create a new PO number, click the **plus** button. Finally, click **Apply and Order** to start the automatic ordering process and continue to the Edit Order form.

The Edit Order form displays items that will be ordered. Review and complete the order by taking the following steps:

- Select a shipping method using the Ship Via dropdown list.
- Select the desired shipping address from the Shipping Address dropdown list.
- If this order will be submitted via the Internet from School Management, make sure the Send via Web check box is selected. See page 84 for instructions on uploading a manual order file.
- Additional items can be added and existing items can be deleted from the order if desired using the Add and Remove buttons.
- On the **By Students** tab, the items in the automatic order will be listed with the assigned student’s name.
- Click **Ready to Send** to prepare the order for submission.
Once the order has been prepared for submission, the following actions are available:

- **Re-open Order** – Allows you to re-open the order for editing.
- **Print Copy** – Prints the Order Report for this order.
- **Save to File** – Saves this order to a file for manual off-site submission. See page 84.
- **Send Now** – Submits this order to A.C.E. via the Internet.
- The order status is updated periodically in the School Management web portal. The status history can be seen by going to www.studentmanage.com and clicking on the **Orders** tab. Possible status items include:
  - **Received** – Order has been received by A.C.E. If an item on your order has been discontinued or substituted for a new item, you will get a status update indicating that change. Your order will be updated to reflect that change.
  - **Submitted** – Order has been submitted to A.C.E.
  - **OnHold** – Order has been processed and A.C.E. is awaiting payment. A **Pay for Order** link will appear when an order has this status. Clicking the link will open a payment page in your web browser, allowing you to pay online via credit card. If you don’t wish to pay online, you must call A.C.E. to make payment arrangements for your order.
  - **Processing** – Order is being prepared for shipment.
  - **InvoicedComplete** – Order has been prepared and is awaiting shipment or has been shipped. Tracking numbers, if available, will be displayed when an order has this status.

**Creating a Manual Order**

Manual ordering is to be used when ordering Non-PACE items from A.C.E. or for ordering from other suppliers. To create a manual order, click **New** and select **Manual Order**. Select the desired supplier from the Supplier dropdown list. The PO number is automatically created for you. However, if you wish to create a new PO, click the **plus** button. Finally, click **Create Order** to continue to the Edit Order form.

On the Edit Order form, you must enter items you wish to order manually. Select **Add**, then search for items by clicking the **search button** under Item #. After adding an item to the order, click **Add** to insert a new row. Continue this process until you
have completed the order. Review and complete the order by taking the following steps:

- Select a shipping method using the Ship Via dropdown list.
- Select the desired shipping address from the Shipping Address dropdown list.
- If this order will be submitted via the Internet from School Management, make sure the Send via Web check box is selected. See below for instructions on uploading a manual order file.
- Click **Ready to Send** to prepare the order for submission.

Once the order has been prepared for submission, the following actions are available for the order:

- Re-open Order – Allows you to re-open the order for editing.
- Print Copy – Prints the Order Report for this order.
- Save to File – Saves this order to a file for manual off-site submission (see below).
- Send Now – Submits this order to A.C.E. via the Internet.
- The order status is updated periodically in the School Management web portal. The status history can be seen by going to [www.studentmanage.com](http://www.studentmanage.com) and clicking on the **Order** tab. Possible status items include:
  - Received – Order has been received by A.C.E.
  - Submitted – Order has been submitted to A.C.E.
  - OnHold – Order has been processed and A.C.E. is awaiting payment. A **Pay for Order** link will appear when an order has this status. Clicking the link will open a payment page in your web browser, allowing you to pay online via credit card. If you don’t wish to pay online, you must call A.C.E. to make payment arrangements for your order.
  - Processing – Order is being prepared for shipment.
  - InvoicedComplete – Order has been prepared and is awaiting shipment or has been shipped. Tracking numbers, if available, will be displayed when an order has this status.
Uploading a Manual Order File

If you do not have Internet access, an order file may be uploaded from an off-site computer.

- From the Edit Order menu item, click **Save to File**.
- **Save** the file to an external hard drive, flash drive, or other portable device to transport it to a computer with Internet access.
- Log in to the Portal at [www.studentmanage.com](http://www.studentmanage.com).
- Click the **Orders** tab.
- Click **Upload Manual Order File**.
- Navigate to the order file and click **Upload**.
- The order status is updated periodically in the School Management web portal. The status history can be seen by going to [www.studentmanage.com](http://www.studentmanage.com) and clicking on the **Order** tab. Possible status items include:
  - Received – Order has been received by A.C.E.
  - Submitted – Order has been submitted to A.C.E.
  - OnHold – Order has been processed and A.C.E. is awaiting payment. A **Pay for Order** link will appear when an order has this status. Clicking the link will open a payment page in your web browser, allowing you to pay online via credit card. If you don’t wish to pay online, you must call A.C.E. to make payment arrangements for your order.
  - Processing – Order is being prepared for shipment.
  - InvoicedComplete – Order has been prepared and is awaiting shipment or has been shipped. Tracking numbers, if available, will be displayed when an order has this status.

Editing an Order

Orders can only be edited if they have not been submitted to A.C.E. electronically, saved to a file, or had a PO printed. Select the desired order and then click **Edit**. Edit items as desired and complete the order using the steps under Creating an Automatic Order or Creating a Manual Order.

Deleting an Order

To delete an order, select the desired order and then click **Delete**. You will be prompted for confirmation before the delete occurs. **IMPORTANT! This action does not cancel any orders with the supplier.** If the order has already been
submitted to A.C.E. or another supplier, you must contact them to complete the cancel/delete process.

**Receive Order**

The Receive Order menu item allows you to receive an order into School Management inventory. Select an order from the Receive Order dropdown list. Items from the order are displayed. To mark all items from the order as Received, click **Receive All Items** on the menu bar. To only receive some of the order items, modify the Qty Received column for each individual item.

**Browse Inventory**

The Browse Inventory menu item allows you to see current inventory items that have been either ordered or are in stock. Note that items already issued to students are not displayed, since they are not technically in stock.

**Adding Inventory**

To manually add an item to inventory, click **Add**. This will open the Add Inventory Manually form.

![Add Inventory Manually form]

To add the new item from this form:

- Click **search** and select the item you wish to add. If the item you are adding to inventory is a new catalog item, click **new** and enter the details for the item.
- Enter the quantity being added to inventory.
• Select the student this item is being assigned to (optional).
• Click Save. The form remains open, allowing you to enter more items to inventory if desired.
• Click Done when you are finished adding inventory.

Issuing Inventory
To issue an inventory item to a student from the Inventory list, select any inventory item that has been previously assigned to that student. Inventory items that do not contain a student name in the Assigned Student column cannot be issued until they have been assigned. (PACEs must be prescribed in Progress Control before they can be assigned to students.) After selecting the item, click Issue. The item is issued to the student and removed from inventory.

Assigning and Reassigning Inventory
To assign an inventory item to a student, select any item that has not been previously assigned to a student and click Assign.

To reassign an inventory item to a different student, select any item that has been assigned to a student and click Reassign. The Select Person form will be displayed, allowing you to choose the student you wish to reassign the item to.

Unassigning Inventory
To unassign an inventory item, select any inventory item that has been assigned to a student and click Unassign.

Changing Inventory Status
To manually change the status of an inventory item, select the inventory item and click Change Status.

Suppliers

The Suppliers menu item allows you to manage curriculum suppliers. The following actions are available:

• New – Adds a new supplier to the system. This action displays the Add New Supplier form. Enter the appropriate values on this form and click Save.
• Edit – Allows you to edit supplier information. Click the supplier you wish to edit and click Edit.
- Delete – Allows you to delete a supplier. Click the supplier you wish to delete and click **Delete**.

---

**Catalog**

Select **Catalog** to view and manage catalog items in School Management. To search for an item in the catalog, type a value in any text box at the top of the grid. This action filters the catalog list to items that match any part of the text entered. You can enter values in multiple text boxes to filter the result set as much as desired. The following actions are also available:

- Manual Update – This option is used to manually update the catalog when School Management is never connected to the web. To perform a manual update, log in to the Portal at [www.studentmanage.com](http://www.studentmanage.com) and download a catalog file from the Update tab. The Manual Update button allows you to select the downloaded file to update the School Management catalog.
- New – Adds a new item to the catalog. This action displays the Catalog Item form. Enter the appropriate values for the new catalog item and click **Save** to add the item.
- Edit – Allows you to edit a catalog item. Only catalog items that have been manually added can be edited.
- Delete – Allows you to delete a catalog item. Only catalog items that have been manually added can be deleted.

In the Auto-Stock column, you can enter the quantity that you would like to keep in stock for that item. When you create an automatic order, you can choose the option to **Replenish PACE Inventory**. This option will add to the order any items needed to maintain the **Auto-Stock** quantity.

---

**Subject Ordering Rules**

The Subject Ordering Rules section allows you to manage ordering rules for the subjects found in School Management. **IMPORTANT** – **You should not make changes on this page unless absolutely necessary.** By default, all subjects are set to (auto). To modify the Preferred Edition, select a new value from the dropdown list and click **Save**.
Reports Section

The Reports menu displays a listing of all the reports in the system, sorted by category. To run a report, click the report row. This action causes the report to load and the report Preview form to be displayed. For most reports, a Parameter panel is displayed, allowing you to select the desired parameters for the report. Make your selection and click Submit to run the report.

For reports that do not require any parameters, the report is displayed without the need to click Submit.

After running a report, various options are available from the menu bar, including Search, Save, Print, and Zoom.

When you are finished with a report, close the Preview form by clicking the red X in the menu bar, clicking the X in the upper right of the form, or choosing File → Exit.
iPad Application

The School Management iPad application can be used to assist with goal check, homework, and attendance. In addition, the iPad can be used to take student photos. In order to use the iPad application, a wireless network is required in your school or Learning Center. **NOTE:** The iPad application is not supported on 1st Generation iPads or when the School Management Server is installed on Windows XP.

Within the iPad application, floating panels can be expanded by swiping to the left and can be collapsed by swiping to the right.

Logging In and Out

After starting the iPad application, you will be presented with the Login option. The Connection dropdown list will contain the School Management server name. If the server name is not displayed in this dropdown list, you will not be able to connect to School Management and should troubleshoot your wireless network.

Enter your Username and Password, then tap **Login**. If the login is successful, you will see the message “Connected successfully!”

To logout at any time, tap the Home menu and **Logout**.

Student Goals and Homework

To manage Student Goals and Homework, tap the Students menu. A list of students is displayed. Selecting any student name allows you to manage homework, goals, and notes for the student. This screen defaults to the current date. Navigate to a different date by using the arrows on either side of the displayed date.

**Homework Slips**

Existing homework slips for the displayed date are shown under the Homework Slips heading. To view or edit an existing homework slip, tap the item. To add a new homework slip, tap
Add Homework Slip. When adding or editing a homework slip, the following fields are available:

- Subject – A drop-down menu for selecting a subject.
- From Page – The beginning page for the homework assignment.
- To Page – The ending page for the homework assignment.
- Task – Include additional information if desired.
- Due – The due date for the homework assignment.
- Status button – Choose Incomplete, Not Signed, or Signed as appropriate.

Additional details can be added in the note area below the Status buttons.

Select Save when you have entered the information as desired.

Attendance

To manage attendance, select the Attendance menu. A list of students is displayed, along with their attendance status for the selected date. To change the attendance for any student, select the student name and select the desired status from the list presented. Changed items are automatically saved to School Management.

Review Items

Review items are items that require special attention, such as overdue items or items that require a Supervisor’s approval. Tap the Review menu to see outstanding review items. Select any item to see more detail or to modify the item.
Details

The Details section allows you to view student notes and homework items in list form.

Notes
To view existing student notes, tap the Notes menu, then select the desired student. Notes for the selected student are displayed. Tap a note to modify it, or select the + sign to add a new note.

Homework
To view existing student homework, tap the Homework menu, then select the desired student. Homework items for the selected student are displayed. Tap a homework item to modify it, or click the + sign to add a new homework item.

Photos
To view existing student photos, select the Photos menu. Thumbnail photos for each student are displayed beside the student’s name. Select the student name to view a larger version of the student’s photo. To take a new photo for a student, use the following steps:

- Select a student.
- Tap Take Photo to take a new image.
- Use a two-finger pinch gesture to scale the image as desired. Drag the image to move it as desired.
- To retake the image, tap Retake.
- To accept and use the image, tap Use.
Release History

Version 1.8

Released Version: 1.8
Date: 11/15/2016
Made program modifications to support ordering through School Management after Distribution Center software update

Version 1.7

Released Version: 1.7
Date: 9/29/2016
Added a check on Family Save to make sure a valid Mailing Address has been entered
Fixed Congratulation Slips fail in Spanish (Mexico) Region settings
Fixed Supervisor’s Progress Report not printing correct Supervisor
Added new layout for High School Transcript report
Allowed Permanent Record to be printed when standardized test scores are missing
Fixed foreign Key errors on Academic Projections
Fixed non-PACE items not displaying on transcript
Changed popup when running reports to only present if the Academic Year is being changed to a new one in which no students have been enrolled yet
Version 1.6

Released Version: 1.6
Date: 3/2016

Removed compatibility with Windows XP
Added compatibility with Windows 8
Added compatibility with Windows 10
Various bug fixes

Version 1.5

Released Version: 1.5
Date: 7/2015

Added ordering features to select individual students
Added ordering features to replenish inventory
Added reenroll feature when switching to new school year
Added Batch Transactions to Billing
Added a Merits Report
Added an Order Report by Student
Added backup location selection
Added the Overall High School Average
Added feature to remove or replace inactive items on orders
Various bug fixes
Version 1.4

Released Version: 1.4.5538
Date: 5/29/2015

Fixed display issue on Academic Projection Report and Goal Check Report

Fixed permissions to allow photos to be taken with iPad and browsing finances

Fixed GPA calculation to use the student’s final academic year

Fixed bug if Administrators Role is renamed

Fixed error with 0 credit subjects

Fixed errors billing for PACEs

Fixed error changing the quarter dates for the current school year

Version 1.3

Released Version: 1.3
Date: 1/20/2015

Added a default permission for admin and supervisors named Override Inventory to override inventory requirements when assigning PACEs

Allowed a user to issue an inventory item, override the requirement to have that PACE in inventory, and not subtract the PACE from inventory when issued

Bug fixes on Inventory and Student Progress Report
Version 1.2

**Released Version: 1.2.5373**
Date: 9/17/2014

Bug fixes to the following items:
- California grading scale
- Printing Congratulations slips
- PACE order labels
- Billing statement
- Subject ordering prerequisites

Version 1.1

**Released Version: 1.1.5330**
Date: 8/5/2014

Academic Projection Toward Graduation added as a new report

A quarterly average added for each subject on the Student Progress Report in addition to the yearly average

Various Bug Fixes

**Released Version: 1.1.5339**
Date: 8/14/2014

Bug fixes on Goal Check

Version 1.0

**Released Version: 1.0.5305**
Date: 7/11/2014

First release of aceconnect School Management